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       Playing with Blocks    

        T  his book looks at creating and managing reusable content, which is content 
that needs to be created only once and then can be used in many diff erent 
drawings. The ability to reuse content was a huge advantage for those early 

drafters that dared to venture into the unknown world of CAD so many years ago. 
If you’ve ever had the pleasure of drafting on a board, you may have used plastic 
templates for things such as circles, furniture in a house plan, and mechanical 
fasteners. Those plastic templates allowed you to draw the same objects over and 
over without drawing them completely from scratch each time. As you will fi nd 
out, blocks are AutoCAD’s equivalent to plastic drafting templates, except they are 
much more powerful.  

  Working with Reusable Content 
 AutoCAD allows you to create blocks that act like geometry templates. A  block  is an 
object that is made up of many diff erent graphical objects and is assigned a name 
to reference when you want to insert the block into a drawing. Blocks are great for 
providing a consistent look to your drawings. You may have already used a block 
in your drawings for a title block that contains a project name, date, and other 
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information that relates to a particular drawing. Blocks can be defined with static 
or dynamic geometry and contain attributes to store static text or allow users 
to enter their own text value. Attributes allow you to assign a varying text value 
that identifies a feature of the physical object that the block represents or to store 
information about the drawing. An attribute can have a different value for each 
instance of a block with the same name inserted into a drawing. Attributes are 
often used to store costing, descriptions, room numbers, and other information 
that you might want to extract out of a drawing. The extracted attribute informa-
tion can be imported into an external application, such as Microsoft Excel, or even 
placed in a drawing as a table object that can represent a bill of materials (BOM) 
or door and window schedule.

Blocks are not the only form of reusable content in AutoCAD. AutoCAD can refer-
ence entire drawings and other files into a drawing, called external referencing. 
When a drawing file is referenced in another drawing, it is referred to as an xref. 
Xrefs allow you to share drawings with others who may need to ensure that their 
drawings match up with yours. For example, you can share a floor plan with the 
building systems contractor and the landscaper at one time. If the floor plan 
is used as an xref, the next time the drawing is opened by the contractors, the 
updates are displayed (of course, the contractors need the updated drawing file). 
AutoCAD is also capable of referencing raster images and PDF, DWF, DWFx, and 
DGN files.

Drawings often display schedules. Sometimes drafters create this information 
in a word processor or spreadsheet program. AutoCAD allows you to copy and 
paste content from Windows-based applications through the use of the Windows 
Clipboard, but doing so causes the information to become static. AutoCAD can 
keep some of this information dynamic through the use of Object Linking and 
Embedding (OLE) and DataLinks.

Being able to reuse content has advantages, but being able to access that  
content quickly makes it even more valuable. AutoCAD provides three inter-
faces that allow you to organize and access content quickly; these interfaces are 
the Blocks palette, the DesignCenter, and the Tool Palettes window. I cover the 
Blocks palette in this chapter, and DesignCenter and the Tool Palettes window in  
Chapter 4 of this book.

Creating Blocks
Blocks can contain the same geometry and annotation objects that you add to a 
drawing file, such as lines, circles, arcs, dimensions, and multiline text. Objects 
that are part of a block look just like individual objects drawn in a drawing.
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AutoCAD allows you to create a block directly from the objects in a drawing with-
out needing to do much more. To create a block, you use the BLOCK command to 
display the Block Definition dialog box (see Figure 1-1). When you create a block, 
you need to know three things:

	» Name: The text string that will be used to identify the block when inserting it 
into the drawing.

	» Base point: The point on a block that helps place it into the drawing when 
you are inserting it. This point is usually established on an object that’s 
selected when creating the block, but you don’t have to use the same point to 
insert the block.

	» Selected objects: The objects to define the way the block looks and behaves 
when inserted into a drawing.

Accessing the Block Definition dialog box
To start the BLOCK command and display the Block Definition dialog box, use one 
of the following methods:

	» On the ribbon, click the Insert tab➪Block Definition panel➪Create/Write Block 
drop-down menu➪Create Block button.

	» At the command prompt, type BLOCK or B and press Enter.

FIGURE 1-1:  
The Block  
Definition  

dialog box.
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Follow these steps to create a block:

1.	 Add the geometry to your drawing that you want to use to define  
a block.

If you want to control the visibility of the objects within the block later, be sure 
to place the objects on specific layers so that they can be turned on and off or 
frozen and thawed.

2.	 Use one of the methods previously listed to initiate the BLOCK 
command.

The Block Definition dialog box (see Figure 1-1) is displayed.

3.	 In the Block Definition dialog box, enter a meaningful name in the Name 
combo box.

The name entered must be unique from other blocks that exist in the drawing, 
or you end up redefining an existing block with the new geometry, which might 
not be what you want to do. The name entered must be fewer than 255 
characters.

4.	 In the Base point area, either click the Pick Point button and specify a 
point in the drawing or enter a coordinate value for the base point in  
the X, Y, and Z text boxes.

The point that you specify will be used as the base point of the block or its 
insertion point. Usually this point is on the geometry that’s selected to define 
the block.

If you clicked the Pick Point button, you are returned to the drawing 
window. Specify a point in the drawing to use as the base point for the 
block. After you specify the base point, you are returned to the Block 
Definition dialog box.

5.	 In the Objects area, click the Select Objects button.

You’re returned to the drawing window once again so you can select the 
objects that you want to add to the block.

6.	 In the drawing window, select the objects you want to add to the block. 
Press Enter to complete selecting objects and return to the Block 
Definition dialog box.

The objects you select can be text, lines, circles, and even other blocks. Any 
object you can select can be added to the block. You can use the Quick Select 
button to the right of the Select Objects button to filter objects by specific 
property values. (See bonus Chapter 1 on the web, www.dummies.com/go/
autocad&autocadltaiofd, to learn more about Quick Select.)

7.	 In the Objects area, click one of the Select Objects modes.
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The different object modes affect what happens to the selected objects after 
the block is created:

•	 Retain: The selected objects are used to define the block but are retained 
as is in the drawing.

•	 Convert to block: The selected objects are removed from the drawing and 
the new block is inserted in the same location as the original selected 
objects.

•	 Delete: The block is defined using the selected objects and the selected 
objects are then removed from the drawing.

8.	 Deselect the Open in Block Editor option (in the lower-left corner of the 
dialog box) for now; I cover that option in a little bit.

If the Open in Block Editor is selected, the block is opened in the Block Editor 
when the Block Definition dialog box is closed. See Chapter 2 of this book for 
more information on the Block Editor and on adding dynamic properties and 
actions to a block.

9.	 Click OK.

The Block Definition dialog box closes. Results vary based on the objects 
selected, the selected objects mode, and the other settings you choose.

Creating geometry on Layer 0 (zero) is usually a “no-no” in AutoCAD, but when 
geometry is added to a block that’s on Layer 0, it inherits the properties of the 
layer on which the block is inserted. This is a great way to verify that a block is on 
the correct layer.

Converting repetitive geometry into blocks
Along with manually creating a block with the BLOCK command, starting with 
AutoCAD 2025, there are two new features that allow you to convert repetitive 
geometry into blocks. These two features are as follows:

	» Search and Convert: Allows you to select objects and search the drawing for 
identical instances of the selected geometry and then convert the selected 
objects into a block and replace all found instances with a block. You start the 
Search and Convert feature with the BSEARCH (or BCONVERT) command, 
which displays the Convert to Block dialog box (see Figure 1-2).

	» Detect and Convert (or Object Detection): Utilizes Artificial Intelligence (AI) 
to identify identical instances of geometry in a drawing and then converts the 
matches into a block and replaces all found instances with a block. You start 
the Detect and Convert feature with the BDETECT (or DETECT) command, 
which displays the Detect palette.
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AutoCAD LT doesn’t support the DETECT command or the Detect palette.

To search for repetitive objects and convert all instances into a block, follow these 
steps:

1.	 On the ribbon, click the Insert tab➪Block panel➪Detect/Search and 
Covert drop-down menu➪Search and Convert button.

The BSEARCH (or BCONVERT) command starts and the following prompt is 
displayed:

Select object to find matching instances to convert to blocks:

2.	 At the Select object prompt, select the objects you want to search for 
identical instances and convert into a block. Press Enter to end object 
selection.

The objects you select are used to define the pattern of objects you want to 
search for within the drawing and then convert to a new block or even replace 
with an existing block. The Search and Convert toolbar is displayed and the 
matching instances are identified in the drawing window.

3.	 In the drawing window, use the Search and Convert toolbar along the top 
of the drawing window to review the instances found. Then click Convert 
on the toolbar.

The Convert to Block dialog box (refer to Figure 1-2) is displayed.

4.	 In the Convert to Block dialog box, click New Block under the Convert 
Instances To area.

5.	 In the Name the New Block text box, enter a meaningful name for the 
new block.

6.	 Under the Basepoint area, click Pick Basepoint (which has a plus and 
arrow cursor on it) and specify an insertion point for the new block in the 
drawing window.

You are returned to the drawing where you can specify a base point for the 
new block. After you specify a point, you are returned to the Convert to Block 
dialog box.

7.	 Under the Assign Block to Layer area, click the drop-down list and select 
a layer on which the instances of the new block should be placed.

8.	 Click Convert and then press Esc to deselect the newly inserted block 
instances.

The originally selected objects are converted to a new block, and all other 
identical instances of the objects are replaced with the new block and placed 
on the specified layer.
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Inserting Blocks
AutoCAD stores blocks in what is called the block definition table. The block defi-
nition table holds information and settings about all the block definitions in a 
drawing. To display a block in the drawing after you create it, you need to insert 
a reference of the block definition. An inserted block in the drawing is known as a 
block reference because it refers to its definition in the block table.

To insert a block into the current drawing file, you use the BLOCKSPALETTE 
(INSERT) command, which displays the Blocks palette (see Figure  1-3), or the 
Insert dialog box if you are using AutoCAD 2019 or earlier. The Blocks palette can 
insert a block defined in the current drawing, an external drawing file as a block 
from the Favorites list, or even a block library. It just depends on where the infor-
mation you want to insert is located. You use the four tabs along the side of the 
Blocks palette to access blocks from the different sources and locations.

To start the BLOCKSPALETTE command and display the Blocks palette, use one of 
the following methods:

	» On the ribbon, click the View tab➪Palettes panel➪Blocks button.

	» At the command prompt, type BLOCKSPALETTE, INSERT, or I and press Enter.

FIGURE 1-2:  
Converting  

identical 
instances of 
objects to a 

block with the 
Convert to Block 

dialog box.
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If you are using AutoCAD 2019 or earlier, use the INSERT command to insert a 
block with the Insert dialog box. The options in the Insert dialog box are similar to 
the Blocks palette, but the following steps vary slightly. If you need information 
on inserting a block, see AutoCAD’s online Help system.

To insert a block into a drawing, follow these steps:

1.	 Start the BLOCKSPALETTE command by using one of the previously listed 
methods.

The Blocks palette (refer to Figure 1-3) is displayed.

2.	 On the Blocks palette, click the Current Drawing tab.

The Current Drawing tab is set as current. From this tab, you can access the 
blocks defined in the current drawing or insert a drawing file. Before clicking  
a block preview or selecting a drawing file, you want to specify the insertion 
options.

3.	 Under the Options area, select or deselect the Insertion Point option. If 
it’s deselected, enter the coordinate value for the insertion point of the 
block in the X, Y, and Z text boxes.

If Insertion Point is selected, you will be prompted for an insertion point during 
the block insertion process after a block preview is clicked or drawing file is 
selected.

FIGURE 1-3:  
The Blocks 

palette is used to 
insert a reference 

into a block 
definition.
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4.	 Select or deselect the Scale option. If it’s deselected, enter the scale for 
the X, Y, and Z axes in the text boxes. From the drop-down list, select 
Uniform Scale to scale the block equally in all three axes based on the 
entered value.

If Scale is selected, you will be prompted for the scale of the block during the 
block insertion process. If the block was created with the Scale Uniformly 
option selected, the scaling method is restricted to Uniform Scale.

5.	 Select or deselect the Rotation option. If it’s deselected, enter the 
rotation angle in the Angle text box.

If Rotation is selected, you are prompted for the rotation angle of the block 
during the block insertion process.

6.	 Deselect the Auto-Placement, Repeat Placement, and Explode options.

When it’s selected, the Auto-Placement uses suggestive placement logic to help 
insert the block into the drawing, while Repeat Placement allows you to keep 
inserting the block until the Esc key is pressed. Finally, if Explode is selected, the 
block is exploded after being inserted. The Explode option is disabled if you 
deselected Allow Exploding option in the Block Definition dialog box when the 
block was created.

7.	 In the Blocks area, click the preview of the block you want to insert, or click 
the Insert File as Block button to select and insert a drawing as a block.

If you clicked a block preview, you are returned to the drawing window and the 
block insertion process starts. Follow the prompts displayed at the command 
prompt to insert the block. If you clicked the Insert DWG as Block button, the 
Select File to Insert dialog box appears.

8.	 If you clicked the Insert File as Block button, in the Select File to Insert 
dialog box, browse and select the drawing file that you want to insert as 
a block. Click Open.

You are returned to the drawing window and the block insertion process starts 
for the selected drawing file.

If you selected the Auto-Placement from the Options area before clicking a block 
preview, you can temporarily disable Auto-Placement while dragging the block by 
pressing and holding Shift+W or Shift+[.

When inserting a block, you can specify its rotation and scale by using the Prop-
erties palette if it’s displayed before you specify the insertion point of the block. 
Using the Properties palette this way also allows you to change the attribute val-
ues and dynamic properties of a block before it’s inserted. I cover attributes later 
in this chapter and dynamic properties of blocks in Chapter 2 of this book.
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Counting Blocks
Blocks inserted into a drawing can be counted. You might want to do this so that 
you know the number of instances of a block in a drawing in order to create a bill 
of materials or even a door and window schedule. AutoCAD provides several ways 
to count blocks in a drawing, and which method you choose depends on what you 
plan on doing with the block count.

The first and simplest way to count blocks in a drawing is with the BCOUNT com-
mand, which is part of Express Tools. This command displays a basic list of the 
blocks inserted into the drawing and the number of instances of each block in the 
Command Line window. Press F2 to expand the Command Line history or press 
Ctrl+F2 to open the Text window to better view the list of blocks. AutoCAD LT 
doesn’t support the BCOUNT command, as it is part of Express Tools.

Another way to count blocks is using the Quick Select dialog box. The Quick Select 
dialog box is displayed using the QSELECT command. Click the Select Objects 
button to select the objects in the area you want to count. Use the Object Type 
drop-down list to filter out all objects except blocks by selecting Block Reference. 
From the Properties list, choose Name and then select the name of the block to 
count from the Value drop-down list and click OK. The count of the block refer-
ences selected is displayed in the Command Line window. (See Bonus Chapter 1 on 
the web at dummies.com/go/autocad&autocadltaiofd for more information on 
Quick Select.)

Yet another way to count block instances is with the Count feature, which was 
introduced in AutoCAD 2022. The Count feature quickly counts block instances in 
a drawing. The blocks inserted into the drawing and the number of instances of 
each block is displayed on the Count palette (see Figure 1-4).

FIGURE 1-4:  
Counting blocks 

can be as easy as 
1, 2, 3 with the 
Count palette.
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You can count all block instances in the entire drawing or within a selected area. 
With the blocks counted, you can choose to simply view the count on the Count 
palette or create a table with the name of the blocks and the number of instances 
of each block. As blocks are added or removed from a drawing, the count of block 
instances is updated in the table. You can display the Count palette with the 
COUNTLIST command.

As if there weren’t enough ways to count blocks already, you can also use the Data 
Extraction wizard to count blocks and other geometry in a drawing. I mention the 
Data Extraction wizard later in this chapter under the “Extracting attribute data 
from blocks” section.

Replacing Blocks
As you work on a drawing, chances are you will have to replace one block with 
another. For example, perhaps the block you initially created representing a valve 
of one type now needs to be changed to a different type of valve. While this might 
be a simple task if you only need to replace one or two blocks in a drawing, it’s a 
very different task if you must replace tens or hundreds of instances of the same 
block throughout a drawing.

Starting with AutoCAD 2024, you can replace selected block references with 
another block defined in the drawing. To replace blocks in a drawing, you use 
the BREPLACE command, which prompts you for the blocks to replace and then 
displays the Block Replacement dialog box (see Figure  1-5). From the Block 
Replacement dialog box, choose the block you want to use as the replacement for 
the selected blocks.

AutoCAD LT doesn’t support the BREPLACE command.

Prior to AutoCAD 2024, you could use the BLOCKREPLACE command from Express 
Tools to replace all instances of one block with another block, not individual 
selected blocks like BREPLACE allows. Recall that Express Tools are not available 
in AutoCAD LT.
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Managing Blocks
Blocks are a powerful feature of AutoCAD and no doubt you will be using them 
as often as you can. AutoCAD offers several tools and commands for managing 
blocks. Some of the ways to manage blocks in a drawing are as follows:

	» Rename a block definition

	» Redefine a block definition

	» Purge a block definition

	» Export a block definition as a drawing file

Renaming a block definition
You can rename blocks with the RENAME command, which displays the Rename 
dialog box. In the Rename dialog box, select Block from the Named Objects list and 
then select the block to rename. Next, enter the new name for the block and click 
the Rename To button.

Redefining a block definition
You can redefine (or edit) a block definition. In earlier releases, you would insert a 
block into the drawing and then explode it. After exploding the block, you make the 

FIGURE 1-5:  
Replacing 

selected block 
references with a 

different block.
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necessary changes to the geometry and then reblock it using the BLOCK command 
again. Or you might use the REFEDIT command, which allows you to open a block 
or an xref so the geometry can be modified. Some issues with using the REFEDIT 
command can be overcome with the BEDIT command. I cover the REFEDIT com-
mand in Chapter 3 of this book.

Redefining a block with the Block Editor is much simpler than exploding and 
reblocking a block after making changes to its geometry. The Block Editor allows 
you to edit a block in its own drawing window. You use the BEDIT command to 
start the Block Editor. Follow these steps to edit a block definition with the Block 
Editor:

1.	 In the drawing window, select the block that you want to redefine.

2.	 Right-click and choose Block Editor from the shortcut menu.

The block definition is opened in the Block Editor.

3.	 In the Block Editor, make your changes to the existing geometry or add 
geometry as you normally do when working in the drawing window.

4.	 On the ribbon, click the Editor contextual tab➪Close panel➪Close Block 
Editor button to exit the Block Editor.

5.	 When prompted to save the changes, click Yes.

You’re returned to the drawing window, and the references to the edited block 
are updated.

Purging a block definition
You can remove block definitions that are not being used and will never be used 
by using the PURGE command and Purge dialog box. In the Purge dialog box, click 
the Purgeable Items tab and expand the All Items node. Then select the Blocks 
node to purge all unused blocks or expand the Blocks node to select the indi-
vidual block definitions you want to remove. After selecting the blocks to remove, 
click Purge Checked Items. (See Bonus Chapter 1 on the web at dummies.com/go/
autocad&autocadltaiofd or the PURGE command topic in AutoCAD’s online Help 
system for more information on the purging unused blocks and named objects.)

To quickly purge all unused named objects from a drawing, select the Purge 
Nested Items option and deselect the Confirm Each Item to Be Purged option in 
the Purge dialog box. Then click Purge All. This purges all nested named objects 
out of a drawing, without stopping to prompt you.
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Exporting a block definition
Blocks created by using the BLOCK or BEDIT commands are defined only in the 
current drawing, but many times you will want to be able to access the block in 
other drawings. The Write Block dialog box allows you to export a block from the 
current drawing to a new drawing file. The Write Block dialog box is displayed 
with the WBLOCK command. Once a block has been written to a drawing file, you 
can click the Insert DWG as Block button on the Current Drawing of the Blocks 
palette or use DesignCenter to insert blocks stored in a drawing; I cover Design-
Center in Chapter 4 of this book. For more information on the WBLOCK command, 
see AutoCAD’s online Help system.

Drawings created with the WBLOCK command are saved in the latest drawing file 
format.

When you open a drawing, you can change the insertion base point of the drawing 
file that is used when inserting it into another drawing. To redefine the inser-
tion base point of a drawing, you use the BASE command or the INSBASE system 
variable.

Enhancing Blocks with Attributes
Blocks can store custom information, and that information can later be extracted 
to an external file or displayed in the drawing as a table object (not available in 
AutoCAD LT). To store custom information with a block, you use an attribute. You 
use attributes to hold information in a block such as a part number, a description 
or even project-related information. You will often find that title blocks contain 
attributes, which allow the user to edit all the attributes at one time instead of 
individually, as you have to do with text or multiline text. Attributes may appear 
like standard text objects, but they’re much more than that. You can change the 
text value of attributes when they’re part of a block.

Adding an attribute to a block definition
Attributes are added to a block in the same way you add other types of geometry, 
such as lines or arcs. First you add an attribute definition to the drawing and then 
you add the attribute definition to the block. The attribute definition is stored in 
the block definition and describes what the actual attribute of the block reference 
should be like. When a block is inserted into the drawing, attributes are added to a 
block reference based on each attribute definition of the block. To create an attri-
bute definition, you use the ATTDEF command to display the Attribute Definition 
dialog box (see Figure 1-6).
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To start the ATTDEF command and display the Attribute Definition dialog box, 
follow one of the following methods:

	» On the ribbon, click the Insert tab➪Block Definition panel➪Define 
Attributes button.

	» When the Block Editor is active, on the ribbon, click the Block Editor 
tab➪Action Parameters panel➪Attribute Definition button.

	» At the command prompt, type ATTDEF or ATT and press Enter.

The following steps explain how to create an attribute definition and add it  
to a block:

1.	 Add the geometry to your drawing that you want to use to define a block.

2.	 Start the ATTDEF command by using one of the methods previously 
listed.

The Attribute Definition dialog box appears (refer to Figure 1-6).

3.	 In the Attribute Definition dialog box, under the Mode area, select the 
options that you want to use for the attribute definition.

Attributes can have six modes:

•	 Invisible: By default, attributes are visible. When this option is selected, the 
attribute is invisible. The attribute’s value is still editable and readable in 
the Properties palette, but it will not be displayed in the drawing and will 
not plot. If an attribute is invisible, you can set the ATTMODE system variable 
to a value of 2 to display all invisible attributes in a drawing.

FIGURE 1-6:  
Creating an  

attribute 
definition.
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•	 Constant: When selected, the attribute has a fixed value that is assigned to 
all references of the block inserted into the drawing and can’t be changed 
unless you use a command such as BEDIT or BATTMAN (Block Attribute 
Manager).

•	 Verify: When selected, you’re prompted to verify that the value entered is 
correct for the block being inserted into a drawing.

•	 Preset: When selected, the default value is automatically assigned to the 
block when it’s inserted into a drawing.

•	 Lock position: When selected, the attribute can’t be moved by using grips. 
You use this mode also when you want to control the placement of the 
attribute with dynamic properties. I cover working with dynamic properties 
in Chapter 2 of this book.

•	 Multiple lines: When selected, the attribute supports multiple lines of text 
instead of a single line of text.

4.	 In the Attribute area, specify the attribute’s tag, prompt, and default value.

The tag is the text you see onscreen before the attribute is added to a block. 
The prompt is what the user sees at the command prompt, or in the Edit 
Attributes dialog box or the Enhanced Attribute Editor (AutoCAD only), when 
inserting or editing the attribute values of a block. The default value defines the 
value that the attribute has when it’s inserted in a drawing. The default value 
can be a plain text string that contains field values or it can be defined with 
special multiline formatting. I cover how to use fields and the BlockPlaceholder 
field in the “Using block placeholder fields” section later in this chapter.

5.	 In the Insertion Point area, select or deselect the Specify On-Screen 
option. If it’s deselected, enter the coordinate value for the insertion 
point of the block in the X, Y, and Z text boxes.

If Specify On-Screen is selected, you will be prompted for the insertion point of 
the attribute after you click OK to close the Attribute Definition dialog box.

6.	 In the Text Settings area, specify the attribute’s justification, text style, 
height, rotation, and boundary width (if the Multiple Lines box in the 
Mode area is selected).

Justification of the attribute controls how the value of the attribute appears at 
its insertion point. The text style controls the font and other text characteristics 
used for the tag and value of the attribute. The Annotative checkbox controls 
whether the attribute scales based on the current annotation scale or matches 
the orientation of the block. Text height specifies the height of the text, and 
rotation controls the rotation angle after the attribute is created. The text 
height and rotation options both have buttons that can be used to specify a 
distance or angle by using points in the drawing. Boundary width defines the 
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width of the bounding box for the attribute text when the attribute is set to 
Multiple Lines; you can enter a number or click Boundary Width to pick a 
distance in the drawing.

7.	 Initially, the Align below Previous Attribute Definition checkbox is 
deselected. Select the option if you have inserted an attribute in your 
drawing and want the next one placed below the one previously created.

When selected, the attribute is positioned below the previously created 
attribute.

8.	 Click OK.

The Attribute Definition dialog box closes, and you’re returned to the drawing 
window. If you selected the Specify On-Screen options for the insertion point, 
specify an insertion point for the attribute definition. If you’re prompted for an 
insertion point, the following prompt is displayed:

Specify start point:

9.	 Start the BLOCK command and create the block as you normally do — 
just don’t forget to add the attribute.

When you insert a block with attributes or edit the attribute values, you’re 
prompted to edit the attribute values in a specific order. The order of the attributes 
is determined by the order they’re selected when the block is created. Select each 
attribute in the order you want them to be displayed when the block is inserted or 
edited. You can use the BATTMAN command to change the order of attributes in 
a block definition.

Using block placeholder fields
When adding and editing attribute values, you can utilize text and fields. Along 
with all the standard fields, you can also use a special field named BlockPlaceholder 
in block attributes. The BlockPlaceholder field allows you to access information 
about the values of custom properties of an inserted block reference. To add a field 
to an attribute’s default value, when you create an attribute with the Attribute 
Definition dialog box (using the ATTDEF command), right-click over the Default 
Value text box and choose Insert Field. In the Field dialog box, select the field you 
want to use along with the property and format based on the field selected. Click 
OK to add the field to the Default Value text box. When editing the attributes of a 
block, in the Value text box for the attribute, right-click and choose Insert Field 
or double-click a field value to open the Field dialog box. For more information on 
fields, see Book 3, Chapter 1.
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Inserting a block with attributes
You insert a block with attributes the same way you insert a block without attri-
butes, except after the block has been inserted into the drawing, you’re prompted 
to change the values for the attributes contained in the block, except for those 
flagged as constant or preset with the Edit Attributes dialog box (see Figure 1-7) 
or at the command prompt.

The ATTDIA and ATTREQ system variables affect how a block with attributes is 
inserted. ATTDIA controls prompting for attribute values with the Edit Attributes 
dialog box at the command prompt when a block with attributes is inserted. 
ATTREQ enables or suppresses the prompting of attributes values when a block 
with attributes is inserted.

Editing an attribute’s value in a block
You can edit an attribute’s value for a block by using the Properties palette,  
the Edit Attributes dialog box (ATTEDIT), or the Enhanced Attribute Editor  
(EATTEDIT) — this works with AutoCAD only. The easiest way to edit an attribute 
value is to double-click the attribute you want to edit or a block that contains 
attributes. Doing so launches the default attribute editor. Make the changes to the 
values of the attributes in the dialog box that is displayed.

FIGURE 1-7:  
Editing attribute 

values after a 
block is inserted.
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Managing attributes in blocks
When you redefine blocks with attributes, you need to be aware of something. 
When you use the BLOCK or BEDIT command to update a block with attributes, 
only the changes to the objects in the block are reflected in the drawing unless the 
block contains attributes that are defined as constant. Any redefined block con-
taining nonconstant attributes will take some extra effort to get them to update 
correctly in the drawing. If you redefine a block and add or change the attributes 
of a block, you must do one of the following:

	» Delete and reinsert the block so all the attributes and property changes are 
used as part of the block reference.

	» Use the ATTSYNC (Attribute Synchronize) command to ensure that all 
attributes in the existing blocks inserted into the drawing are updated. 
(Available only in AutoCAD.)

	» Use the BATTMAN (Block Attribute Manager) command to modify the 
properties of attributes in a block. You can use this command to change the 
order in which attributes appear when inserted along with other properties 
such as color, layer, and even text style.

Extracting attribute data from blocks
You can extract attributes from a drawing by using the Attribute Extraction dialog 
box (ATTEXT), which you can find in both AutoCAD and AutoCAD LT.

You can also use the Data Extraction wizard (DATAEXTRACTION), which is avail-
able only in AutoCAD. Attributes can be extracted to external data files and brought 
into your favorite spreadsheet or database program, or in AutoCAD you can extract 
attribute values and create a table object that summarizes all like values. For more 
information on extracting attributes out of your drawing, search for “extract 
attributes” in AutoCAD’s online Help system.
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